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Remarks

Some images were taken from the first version of this tutorial with 2.67b. So do not be confused, 
the explanation works also with the new version and where required, the images were updated.
This tutorial is an update of the tutorial from WS2013-14. Please use this actual version, because it 
was slightly improved and extended.

Target

In this tutorial, the swan model – created in the previous tutorial – will be dressed by using different
textures. In addition, the swan starts to move. He will be animated to move his wings and his neck.

Abbreviation

RMB Right Mouse Button

LMB Left Mouse Button

! For using most of the shortcuts discussed in this tutorial, you have to be sure that the mouse 
cursor is WITHIN the view port of the 3D View !

Base

Blender Visualization Tutorial WS2014-15 II Part I

Loading and Storing the Image

The shape of the body might be okay, but the swan is naked, he will not like this a lot! So let's do 
something against it!

What we want to do: we want to paint a texture onto the surface of the swan. For this purpose, first 
we have to load an image into Blender like this:

In Object mode, 1) open the texture tab, 2) select an empty texture, such as here shown at the 
image. We do not want to overwrite the original texture, we will use it for the final “dress” for the 
swan. 3) click “New”.

http://www.cellvisualization.org/
http://www.blender.org/
http://www.cellmicrocosmos.org/Cmforum/viewtopic.php?f=21&t=760


Then, 1) select “Image or Movie”, then 2) press the “open” button and select the appropriate image 
from your hard disk (the image below shows an already selected state), and 3) deselect these 
textures, because we do not want them to be rendered directly to the surface of the swan:

In our example repeat this process also for the second image. I use for this purpose the images:

swan_texture_top__flickr_William_Veder.jpg
swan_background_and_texture_bottom__flickr_Excelglen.png



You find this images at the URL of this tutorial in a ZIP archive (see top page).

An important hint: the selected images are now linked to the file. Therefore, you always have to 
take care that the images are in the original folder so that Blender is able to find these files. The 
advantage is, that you can change the image with another tool and update it then in Blender. If you 
do not need this functionality, it is better to embed the images. You do it in the following way: just 
click on this symbol:

This state indicates that the image will be packaged with your file.

The final preparation step is now to make sure that during rendering the texture is shown. This is 
done by selecting the Material section and activating the option “Face Textures” in the Options 
panel:

If you press not F12 to render the scene, still, something is missing. What do you see now? A swan, 
yes, but still, it is naked. Scandalous! To come out of this awkward affair, we have to tell the swan 
which dress to choose and how to dress. This we will do now in the following steps!



Seam to the Swan

Before we continue, make sure that there are no double vertices found on the center of the swans 
body where the two mirrored sides meet. In this example, a superfluous vertex is selected which has
to be deleted (vertex delete). Remove all these nodes. You could try to achieve this goal by 
changing to “Texture Mode”, selecting all nodes and press W and select “Remove all Doubles”.

Now, we have to create a seam. A seam defines the borders of the area, onto which the texture is 
placed later on.

Go to Edit Mode, select the “Edge select” mode:

SHIFT+select all edges which should be defined as the seam. Of course, they all have to be directly 
connected. Choose the border between the top wings and the bottom wings and leave the complete 
neck out!

The red line should only indicate the seam which is marked in Blender by the yellow line.

After all edges have been selected (and make sure they are all connected!), select “Mark Seam” like



this:

Do the same with the neck. First, the upper part:

Mark the seam. And then, the bottom part:



Mark seam again – here, only a selected few edges differ from the ones selected in the previous 
image.

→ Blender_Tutorial_WS2014-15_2pt2__1.blend

Texture to the Swan

Now switch to UV Editing mode:

On the left side, you see the area for the textures, the UV/Image Editor, on the right side, you see 
the 3D view:



Note: A funny new behavior of Blender 2.7 is that sometimes the column on the left side is not 
shown. In this case, just click on the “plus” sign to open the column, you will need it in the 
following:

 
It might be also, that the column above appears in the center like in the example at one of the 
following pages. So it will be a surprise for you, but the functionality is the same. 

Now, in Edit Mode, select the whole swan, select Mesh → UV Unwrap → Unwrap:

The four shapes which were marked by a seem should appear. Now, try to place the two unwrapped 
shapes in a convenient way to add the textures in the next step. For this purpose you can use the 
regular S, G and R modifiers. To select a complete shape, RM onto the shape and press L, or, 
alternatively, change to the “Island” shape selection mode:

It should look similar to this:



In my case, I have two additional shapes, which were not selected as a seam. This has happened 
because I selected the up and down seam from the top and bottom view, and this part was not 
visible from the top/bottom:

This is not a problem, you only have to find out were these additional shapes a located and then you
can use later the appropriate texture image.

But the area is empty, this is a little bit boring. So let us add a new texture image. Press:

and use the following settings:

The width and the height define the resolution later on, so it is important to choose the correct 
settings here. The UV Grid will make a nice grid which can be compared to the one in the 3D View. 
All what we have to do now is to switch the 3D View to “Texture” Mode! And in addition, switch 
also the UV/Image Editor to “Paint” Mode! See the arrows (the 2D shape is not visible at the 
moment, but believe me, it is still there!):



[FB]

If you click now onto the “Texture Mask” image on the left side of the UV/Image Editor window, 
something like this will be shown:

[FE,FF]



Select now the texture for the bottom and select the “Stencil mode” for the “Brush Mapping”!

[FE]

If you move the mouse pointer inside the window of the UV Editor, a stencil-like image will appear.
You can change the position of this image by keeping RM pressed.

[FE]

This works in the 2D view on the left side, as well as the 3D view on the right side. 

Make sure that the strength of the painting is set to 1, otherwise a semi-transparent texture will be 
drawn. In addition, it is also possible to rotate the image by changing the value shown here at the 
left side:



So, after you have painted the complete bird from the top view, you should examine the swan from 
different perspectives in the 3D View and maybe extend the textures with the stencil.

Very important: save the image. Otherwise, all your results will be lost after you close the project:

[FE]

Now do the same thing for the upper part of the swan. Choose another texture for the top. You can 
also change the size and the rotation of the texture, if the original image is not aligned correctly to 
the mesh. Here, the rotation of the stencil image was changed:



[FF]

And now, press F12 to render the image:



And here is your swan!

→ Blender_Tutorial_WS2014-15_2pt2__2.blend

Bones to the Feathers

What we want to do now, is to add some movement. But maybe you have heard that also birds 
require bones to move. So, what we are about to do now is, to create a skeleton which we will use 
then in the following step to add some movement.

First, go back to the Default Mode ... 

… and then, leave the Texture Mode by going back to 1) Object Mode and let us switch to 2) 
texture mode.

Let us add now bones. First, add a bone by using:

Add → Armature → Single Bone



Place and scale it like shown here:

[FB,FF]

Go to Edit Mode and select the joint of the bone, as the one selected in the previous image, and 
press E for extend. It is a good idea to press CTRL during the extension process, because the 
placement of the joints is restricted to the grid and it is easy to keep the joints in the center of the 
image. Pay also attention that each joint is beneath an edge of the mesh. This is important for the 
movement later. Do this until the whole base of the body and the neck include the skeleton.

[FB,FF]

If you added a beak, you might want to add a second bone to the beak of the swan:



[FB]

Now, we want to add the bones for the wings. For this purpose, we want to save time by using again
the mirror modifier. In the “Armature Options” (usually on the left side of the window), select “X-
Axis Mirror”: 

Select now the joint of the initial bone, and while holding SHIFT press E. Now, the added bone is 
mirrored on the left side:

[FF]

Repeat these steps until it looks like this:

[FF]

→ Blender_Tutorial_WS2014-15_2pt2__3.blend



Feathers to the Bones

Now the bones have to be connected to the body. Select the mesh in Object Mode and add the 
Armature to the swan by adding the modifier “Armature”:

And now, select in the modifier the Object the mesh has to be connected to, called “Armature”:

Now, select the bones again and select: “X-Ray” in the Object Settings (it will enable you to see the 
bones also if they are covered by the body's mesh):



Then, switch the bones to “Pose Mode” (make sure the bones a.k.a. “Armature” are still selected):

Select now the mesh again and switch them to “Weight Paint” Mode:

Now, it should look like this from the top (NUM 7):

You should deactivate the “limit selection to visible”, because we want to apply the bones now to 
meshes and during the painting both sides of the swan should be selected:

By using only the top view, select the first bone with RM, and then use LM to paint an area. Paint 
only the neighboring area. Because we deactivated the “limit selection to visible” mode, now the 
top and the bottom mesh are connected to this bone:



Use the options in the red circle to change the way the mesh is painted (e.g. the size of the brush). 
Do this now for every bone and make sure, that in the end the complete mesh is attached to a bone. 

To test, if the mesh was attached correctly to a bone, just rotate the bone by e.g. using R. If some 
awkward behavior is noticed, you have to correct the attachment.

Examples for a bone inside the neck, at the top part of the beak, a part of a wing and the wing's end:

→ Blender_Tutorial_WS2014-15_2pt2__4.blend



Animating the Swan

Now, leave the weight paint mode of the mesh, switch it to object mode. And then, choose the 
screen layout “Animation”:

It should look now like this:

The window #1 shows the Dope Sheet editor which we will now use to make the animation of the 
movement. The idea here is, to define a small segment of a wing flap which can then be repeated 
multiple times.

The window #2 shows the F-Curve Editor which can be used as an alternative way to change the 
values of the animation – e.g. coordinates – by using curves. We will not use it in this tutorial.

The window #3 is well-known to you, because you always see this time line. This time line is used 
in the end to create the basic animation, e.g. move the swan from one position to another one. The 
button in the circle we will use in the next step.

The window #4 is used to define the length of the animation, here the animation lasts from frame 1 
to frame 250. The size of the rendered image is 50% of 1920X1080, so 960X540. Just press F12 or 
the “Render” button and the output is being rendered.

Now we have to tell the program that we want to record the Locations and Rotations of the bones. 
We do so by just selecting this option at the bottom of window #3 (see also red circle there):



Make sure that you are at the first frame #0 of your animation:

And then, make sure that the bones are still selected in the 3D view and that you are in “Pose 
Mode”!

Select all bones of the swan by pressing A and then press  and you just 
created your first frame.

Now we have to think about the length of the animation. Let us say, we want to make a movement 
of different wing flaps for ca. 200 frames. Our end animation, where the swan is moving from one 
point to another one, will need 400 frames. Because we have 200 frames for one basic movement, 
we will make a time point at every 20th frame during the following animation.

But how is the swan moving? Thanks to photographer Smudge 9000/flickr.com, we have this very 
nice picture of a swan's takeoff:

Photo: © Smudge 9000/flickr.com

We see: the swan is flapping, and then it is gliding! So we will take this into account during the 
animation process. Also you may see here, how the neck of the swan behaves in comparison to the 
rest of the body.

First of all we can see that the neck is not in parallel to the body during the flight. But during the 
gliding process (while the wings are extended), it is nearly in parallel.

Go now to the frame 20. Change now the rotation of the different bones moving the wings and the 
first bone of the neck – as shown in the photo above at the first position – and press A (maybe two 
times, first to deselect the actual bone and the second time to select all bones – do not forget this!) 
and then  again.

During the movement, you should use the following tricks: press R and then Y (for the wings) or X 
(for the neck etc.) to rotate the wing only along the Y or X axis, respectively. And during the 
movement, press CTRL to move the in steps with a value of 5.



From the side:

From the back:



If you move now the slider in time line(window #3) backwards from frame 20 to frame 0, you see 
the wing movement. We want to copy this wing movement 3 times – in that way, that the swan flaps
three times the wings. Go back to frame 0, select in the DopeSheet (window #1) with right click 
onto one of the first (at the top!) which marks the whole frame and press CTRL+C (for the position 
of the markers see the arrows on the following image). Go now to frame 40 and press CTRL+V. Do 
the same at frame 80 and 120. Now go back to frame 20, select again one of these markers and then 
copy it to frame 60 and 100.

Your window should look like this now:

Now our bird should be gliding some time with nearly now wing movement. Go to frame 140 and 
move the wings like this:

You might also want to change the position of the neck a little bit again. Again, select all bones and 
make a key frame. And repeat the process for frame 160 and 180. Here, you should keep the wings 
in a similar position but change the rotation a little bit so that it looks like gliding.

Because we want to make a loop in the next step, we have to finish the movement. This we do just 
by copying frame #0 in the Dope Sheet – just as we did it before – to frame #200.

Now we want to make a loop of this movement. Select in the DopeSheet (window #1) 

View → Auto-Set Preview Range

(You could also press P to set the Preview Range manually). It should look this now:



and if you press play , the animation runs now in a loop. Press ALT+A to play 

the animation forward, and ALT+SHI(F)T+A to play it backward (I added a secret comment here 
regarding this nice shortcut for a play function.)

→ Blender_Tutorial_WS2014-15_2pt2__5.blend

Duplicating the Swan Animation

The swan is animated, now we want to repeat the flapping process multiple times. Change from the 
DopeSheet (window #1) to the NLA Editor.

Press now the snow flake (red circle).

Select the box with RM entitled “ArmatureAction” and press SHIFT+D to duplicate it and move it 
with the mouse to frame 200:

We have now 400 frames of swan animation. It is now no problem for to extend it for 1,000 frames,
but for now, 400 frames are enough.

If you want to smooth the mesh of the swan, you might want to add the “Subdivision Surface” 
modifier to the mesh, and also do not forget to toggle smooth shading:



→ Blender_Tutorial_WS2014-15_2pt2__6.blend

The next tutorial will continue with the generation of a landscape which can be used as a stage over 
which the swan is flying. 
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A nice texture tutorial:
Blender-Tutorial - Texture Painting (AgenZasBrothers)
http://www.youtube.com/watch?v=l06iV1TSWm4
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